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Figure 1. ADS1119 Evaluation Module (BOOSTXL-ADS1119)

The ADS1119 BoosterPack™ plug-in module (BOOSTXL-ADS1119) allows users to evaluate the
functionality of the ADS1119. The ADS1119 is a 16-bit, delta-sigma, analog-to-digital converter (ADC) that
can be configured as four single-ended inputs or as two differential input pairs. Data rates range from
20 SPS up to 1000 SPS. Processors can communicate to the ADS1119 though an I>C interface.

This user's guide includes a detailed description of the hardware (HW), bill of materials (BOM), schematic,
and software GUI when using the LaunchPad™ MSP-EXP432E401Y.

Table 1. Related Documentation

Device Literature Number
ADS1119 SBAS925
MSP-EXP432E401Y SLAU748
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1 Introduction

The BOOSTXL-ADS1119 is a fully-assembled evaluation platform designed to highlight the ADS1119
device features and its various modes of operation.

The BOOSTXL-ADS1119 interfaces to LaunchPad™ development platforms using the XL connector
format. However, to use the ADS1119 BoosterPack™ GUI, a specific LaunchPad™ (the MSP-
EXP432E401Y) must be used. The LaunchPad™ communicates to the ADS1119 through its I°C interface
and also acts as a USB-to-PC GUI communication bridge.

NOTE: The BOOSTXL-ADS1119 requires an external master controller to evaluate the ADS1119.

The MSP-EXP432E401Y LaunchPad™ is controlled by commands received from the ADS1119
BoosterPack™ GUI. The LaunchPad™ sends data to the GUI for display and analysis. If a LaunchPad™
is not used, the BoosterPack™ plug-in module format allows an alternate external host to communicate
with the ADS1119 using the LaunchPad™ connectors.

The BOOSTXL-ADS1119 EVM incorporates circuitry and components with the following features:

e The 16-bit ADS1119 delta-sigma ADC with four single-ended input channels (or two differential),
2.048-V reference, and I°C interface.

» External reference and analog inputs can be connected either through a header or screw terminal
block.

» 3.3-V or 5-V selectable analog power supply.
» LEDs to indicate active power supplies.
« I°C interface for the ADS1119 device configuration and communication.

Figure 2 shows the BOOSTXL-ADS1119 EVM architecture along with key components and blocks listed in
the features.

3.3V
avpp | Analog Power LaunchPad
Source 5v Power
LEDs
AVDD 3.3v 3.3v
Analog Inputs ADC 12C / GPIO LaunchPad 12¢ EEPROIg
[ + RC Filters Interface evice
Analog Header |
and
Terminal Block
ADC Reference
+ RC Filter
Figure 2. Block Diagram
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Quick Start

The quick start in Figure 3 shows a minimalist view of the startup procedure to get the system up and
running. Details regarding these steps can be found in Section 4.

Quick Start Guide: BOOSTXL-ADS1119
Evaluation Module

E:fu:::-:dp‘%nsdqlqnqsga;;::tfrgla.;k- GUl Remaowve jumper JPEand place on the LaunchPad 5 power connector JP1 to the
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httphwaneti comitool/boo stxl-ads1149 and connectthe micro USE cable to the PC
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Figure 3. Quick Start

Step 1

Download and install the GUI software from the BOOSTXL-ADS1119 tools folder. This software install
also includes the firmware file required for communication with the LaunchPad™. The firmware file can be
installed to the LaunchPad™ through the GUI software or by using the UniFlash cloud tool. A desktop
version of UniFlash is also available for download if needed.

Step 2

Connect the LaunchPad™ to the PC and download the firmware to the LaunchPad™ using the micro USB
cable provided with the LaunchPad™ Kkit.

Connect the LaunchPad™

Connect the USB cable from the PC to the micro USB connector on the top portion of the LaunchPad™
(XDS110 portion of the LaunchPad™). A green LED lights up indicating that the LaunchPad™ is powered.

Flash the Firmware to the Launchpad

There are two possible methods to flash the firmware to the LaunchPad™. The first method involves using
the BOOSTXL-ADS1119 GUI software while the second method uses the UniFlash program where links
are provided in Section 2.1.

2.2.2.1 Firmware Download Using the GUI Software

The required BOOSTXL-ADS1119 firmware and the programming functionality for downloading the
firmware to the LaunchPad™ is included as a part of the GUI software. The process involves connecting
the proper COM port required for programming the device. The Connect icon is located in the lower left
corner of GUI window. If the correct serial COM port cannot be found, the desired port can be selected
from the Options drop down menu and selecting Serial Port; see Figure 7.
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From the File drop-down menu select Program Device from the menu options as illustrated in Figure 9. If
the GUI detects the LaunchPad™, the firmware is automatically programmed into the LaunchPad™.

When the firmware program is successfully downloaded (see Figure 10), the GUI software can now
communicate with the LaunchPad™.

2.2.2.2  Firmware Download Using the UniFlash Software

An alternate method for downloading the firmware is by using the UniFlash programming software. This
tool is useful in case there is an issue using the Program Device option in the GUI software.

2.2.2.2.1 Start the UniFlash Program and Choose the Correct LaunchPad™

Start the UniFlash program and begin a New Configuration (Figure 11) and select the LaunchPad™ MSP-
EXP432E401Y.

The connection type is automatically chosen based on the LaunchPad™ being used. Verify that the Texas
Instruments XDS110 USB Debug Probe is selected and press Start.

2.2.2.2.2 Choose the Firmware File and Flash the LaunchPad ™

The firmware file is located in the folder Program Files (x86)\Texas Instruments\ADS1119\firmware. Use
the Browse button to browse to folder containing the firmware file. The firmware file can also be dragged
and dropped into the browse window provided in UniFlash.

When the desired firmware is selected, use the Load Image button to load the firmware into the
LaunchPad™,

Verify that the firmware installed successfully by checking the Console portion of the UniFlash tool at the
bottom of the GUI window.
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2.3

Step 3

After the firmware file has successfully downloaded to the LaunchPad™, unplug the USB cable from the
LaunchPad™. Further communication takes place using the USB connector located at the opposite end of
the LaunchPad™. For proper power to be supplied to the BOOSTXL-ADS1119, remove the jumper from
the middle of the LaunchPad™ at JP6 and place the jumper on the center pins of JP1; see Figure 16. This
jumper takes the available USB power from the bottom connector and applies the voltage to the remainder
of the board.

Before plugging the USB cable to the bottom LaunchPad™ USB connector, properly align the connectors
(as shown in Figure 4) and attach the BOOSTXL-ADS1119 BoosterPack™ to the bottom set of
connectors on the LaunchPad™.

0000000000

2.4

Figure 4. LaunchPad™ and BoosterPack™ Combo

When the BoosterPack™ is attached, plug the USB cable into the bottom connector of the LaunchPad™
and also to the PC. The LaunchPad™ communication to the PC is USB communications device class
(CDC) using a virtual COM port. Windows® 10 automatically installs the required driver. Earlier versions of
the operating system may require a manual driver installation. The required driver files can be found in the
installation directory Program Files (x86)/Texas Instruments/ADS1119/drivers.

Step 4

From the Windows Start menu, go to the Texas Instruments folder and under ADS1119 start the GUI
application. The communication should automatically connect. If the hardware does not connect, manually
try to make the connection by clicking on the connect icon in the lower left portion of the GUI. A different
COM port can be selected by using the information from Section 2.2.2.1.
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3 BOOSTXL-ADS1119 Hardware Overview

This section lists various onboard components that are used to interface analog inputs, analog reference,
digital interface, and power to the BOOSTXL-ADS1119 EVM. Figure 5 shows a top-level view of the
board.
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Figure 5. BOOSTXL-ADS1119 Overview

3.1 Connectors for the Analog Input

The BOOSTXL-ADS1119 EVM is designed for easy interface to analog sources through a 100-mil header
(J5) or to a screw terminal block (J6). J6 also allows for an external reference input. Table 2 shows the
input configuration for J5 and Table 3 shows the configuration for J6. Both connectors are clearly labeled
on the PCB silkscreen for easy input connection identification.

Table 2. Header Input (J5)

J5 Connector Pin Description
J5:1 Analog input for AO of the ADC
J5:2 Analog input for Al of the ADC
J5:3 and J5:4 BoosterPack™ plug-in module ground
J5:5 Analog input for A2 of the ADC
J5:6 Analog input for A3 of the ADC

Table 3. Terminal Block Input (J6)

J6 Terminal Block Inputs Description
J6:1 BoosterPack™ plug-in module ground
J6:2 Analog input for A3 of the ADC
J6:3 Analog input for A2 of the ADC
J6:4 Analog reference input REFN
J6:5 Analog reference input REFP
J6:6 Analog input for Al of the ADC
J6:7 Analog input for AO of the ADC
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3.2

3.3

3.4

The analog inputs can range from GND up to AVDD, which is the analog supply voltage. A maximum of
four single-ended inputs, or two differential inputs may be applied to the ADS1119. The user can configure
the input channels through the ADS1119 BoosterPack™ GUI. Each of the analog inputs have a series 1-
kQ resistor with a 100-nF differential capacitor between inputs and a 10-nF common-mode capacitor to
GND for filtering noise and aliasing. Figure 27 provides a schematic that details the input filtering.

Voltage Reference

The ADS1119 contains an internal 2.048-V reference and no external reference is required. The analog
supply can also be used as reference input by installing a 0-Q resistor at R7. An external reference can be
applied to the terminal block REFP and REFN connections available on J6 (see the analog input terminal
block in Figure 5). The external reference input is limited by a minimum of 0.75 V and a maximum of the
analog supply voltage (AVDD). The REFN input is connected to the board ground by default through the
0-Q resistor R8.

Digital Interface

The BOOSTXL-ADS1119 interfaces to the MSP-EXP432E401Y LaunchPad™, which in turn
communicates with the computer through USB. The two devices are on the BoosterPack™ and they both
communicate using I?’C. U4 is an EEPROM used to hold device and board manufacturing information. The
EEPROM information is not currently available to the GUI. U1l is the ADS1119 and communication from
the GUI allows for register read and write as well as ADC conversion data collection.

BOOSTXL-ADS1119 Digial 1/0

The BOOSTXL-ADS1119 EVM supports the I°C digital interface and functional modes as described in the
ADS1119 datasheet. The LaunchPad™ operates at a 3.3-V logic and /O level. The ADS1119 has both
DVDD and AVDD. DVDD is the digital supply and is fixed to the same voltage level as the LaunchPad™
processor so no level shifting is required. The I?*C communication is through LaunchPad™ ports PN5
(SCL) and PN4 (SDA). GPIO pin control for the Reset pin of the ADS1119 is controlled by port PK6. The
Reset control pin defaults high (not in reset). GPIO port PK7 is an input port pin used to interrupt the
processor when a new conversion result is ready to be read from the ADS1119. Table 4 lists the port to
connector pin interface.

Table 4. MSP432E401Y Port to BoosterPack™ Interface

MSP-EXP432E401Y GPIO Port

BOOSTXL-ADS1119 Connector
Pin

SCL (PN5 - Output)

J1:9

SDA (PN4 - Input/Output)

J1:10

RESET (PK6 - Output)

J4:32

DRDY (PK7 - Input)

J4:31
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3.5 Power Supply

Both the LaunchPad™ 3.3-V and 5-V supplies are used for the BOOSTXL-ADS1119. The digital supply is
3.3 V and supplies the ADS1119 DVDD supply input. AVDD is the ADS1119 analog supply and can
accommodate either 3.3-V or 5-V operation. The choice of analog supply voltage is selected by jumper
JP2. Figure 6 shows that JP2:1-2 selects the 5-V supply source and JP2:2-3 selects the 3.3-V source.
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Figure 6. Analog Supply Jumper

The 3.3-V source comes directly from the LaunchPad™ and when available on the BOOSTXL-ADS1119
the D2 LED lights up indicating that the supply is active. The LaunchPad™ 5-V source is often less than
5 V. To achieve a stable voltage when operating at a 5-V AVDD, U3 is used to charge pump the
LaunchPad™ 5-V source and regulate for a fixed 5-V output. U3 can be disabled by installing jumper JP1,
but by default this jumper is not installed. When U3 is active, LED D1 lights up indicating the supply is

available. TP1 can be used to monitor the AVDD supply voltage. Figure 6 shows jumper placement and
LED locations.

4 Setup Details

Getting the BOOSTXL-ADS1119 and MSP-EXP432E401Y LaunchPad™ combination to communicate
with the PC requires firmware to be installed in the LaunchPad™; see Section 4.2. This firmware is made
available as part of the ADS1119 BoosterPack™ GUI software installation. Depending on which operating

system is used, driver installation may be needed. The drivers are also included as a part of the GUI
software installation.

4.1 ADS1119 BoosterPack™ GUI Installation
Download and install the GUI from the BOOSTXL-ADS1119 tools folder. The license agreements must be
accepted or the software will not install. Follow all remaining on-screen instructions to complete the
installation.

A cloud version of the GUI is also available from dev.ti.com in the software gallery.
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4.2

42.1

Flash the Firmware to the LaunchPad ™

There are two possible methods to flash the firmware to the LaunchPad™. The first method involves using
the BOOSTXL-ADS1119 GUI software and the second method uses the UniFlash program.

Firmware Download Using the GUI Software

The required BOOSTXL-ADS1119 firmware and the programming functionality for downloading the
firmware to the LaunchPad™ is included as a part of the GUI software. The process involves connecting
the proper COM port required for programming the device. The Connect icon is located in the lower left
corner of GUI window. If the correct serial COM port cannot be found, the desired port can be selected
from the Options drop-down menu shown in Figure 7 and selecting Serial Port.

Options Tools Help
= me Ty SerialPort..

o ADS1119

3577

4 o e / 8

Quick Start Settings Data Capture Registers Collateral

Powered By GUI Composer™

g @  COM10:9600 waiting for data QI TeEXAS INSTRUMENTS

Figure 7. Serial Port Selection

Manual selection of the COM port may be required for the GUI to program the LaunchPad™. The correct
COM port used for device programming can be found from within Windows by using Device Manager or
Devices and Printers. Search for the XDS110 device, then highlight and right-click the device name to
select Properties. On the Hardware tab there should be two COM ports listed. The correct COM port is
listed as XDS110 Class Auxiliary Data Port.

10
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If a change of COM port is required, select Serial Port from the Options menu. The serial port

configuration shown in Figure 8 displays a drop-down menu for available COM Ports and Baud Rates
settings. Select the desired COM port from the drop-down menu. Use the recommended baud rate setting

and click OK.

File Options Tools Help

Serial Port Configuration

Ports: | COM10(Texas Instruments Incorporated) ¥

Baud Rates: | 9600 (recommended) ¥

oK CANCEL

® Texas INSTRUMENTS

g @  COM10:9600 waiting for data

Figure 8. Serial Port Settings

From the File drop-down menu shown in Figure 9, select Program Device from the menu options. If the
GUI detects the LaunchPad™, the firmware is automatically programmed into the LaunchPad™. The
connect icon shown in the lower left corner of the GUI may show a line through the connect icon. The icon
with the line through it is showing that the device is connected but does not communicate using this COM
port for changing device settings or collection of data. The COM port currently selected is for device

programming only.

File Options Tools Help
¥ Program Device...
@ Load Registers

B SsaveRegisters

B saveRegisters As...

7 = '™ / 8

Quick Start Settings Data Capture Registers Collateral

Powered By GUI Composer™

& co  com109600 wating for data &3 TExas INSTRUMENTS

Figure 9. Program the Device
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When the firmware is successfully downloaded (see Figure 10), the GUI software should now be able to
communicate to the LaunchPad™. Communication to the BoosterPack™ requires the use of a different

COM port than the one used for programming. The correct COM port for communication can be chosen
when all the steps in Section 4 are complete.

File Options Tools Help

Program Loading Status

@ Flash Successfull

0K

& c COM109600 waiting for data . i3 TExas INSTRUMENTS

Figure 10. Programming Successful

42.2 Using the UniFlash Tool to Program the LaunchPad ™

The UniFlash program can be accessed via the cloud or by download. When using the cloud version for

the first time the Tl cloud agent must be installed. Follow all instructions by downloading and installing the
correct cloud version for the operating system being used.

4221  Flashing the Firmware

When the UniFlash program is accessed, either by cloud or download, start the process by first plugging
in the LaunchPad™ to the XDS110 programming connector at the top of the LaunchPad™. A green LED
lights up indicating that power is available and the cloud agent driver recognizes and is installing the
appropriate drivers for the LaunchPad™. For any issues with the installation or operation of the UniFlash
program, click on the Help icon in the UniFlash menu bar.

1. Inthe UniFlash program, select the MSP-EXP432E401Y LaunchPad™ from the drop down list as
illustrated in Figure 11 to start a New Configuration.
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Figure 11. UniFlash: New Configuration

2. As shown in Figure 12, the Selected Connection automatically selects the Texas Instruments XDS110
USB Debug Probe. Press Start to continue.

1B T Cloud Tools x )/ @ unitesh x Y e - x
C | @ Secure | httpsy/dev.ticom/unifias 1
# UniFlash  Sesson~  About @Hep B Sertings & 20864359
~ Detected Devices
Status: « Inactive - Click ‘Detect to detect devices Setting: Manual ~

~ New Configuration
ORI " ——

v x

~ Create Session From Existing Target Configuration File
=) : coxmi fle to create 2 new session.

Figure 12. UniFlash: Choose Connection
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3. From the Program tab shown in Figure 13, Browse to the Flash Image to be installed. The firmware file
is found under the Program Files (x86)\Texas Instruments\ADS1119\fimware folder.

I} Ti Cloud Tools x /' 2 Uniflash x e - X
<« C' | & Secure | https;//dev.ti.com/uniflash/#!/main/ms;

ction/Program,

3 UniFlash  Session~  About

@ Help &8 Sewings  § a0864359

Configured Device : Texas Instruments XDS110 USB Debug Probe > MSP432E401Y [downl

CORTEX_M4_0

I Program Select and Load Images

Settings & Utilities Flash Image(s)

Standalone Command Line

Reset Actions

[Click here to query available reset options]

+ Quick Settings

Create your personalize settings view. Click to add settings

0O Console % Verbose X Close

Figure 13. UniFlash: Browse to Firmware

4. When the flash image file is located, as shown in Figure 14, press the Load Image button to start the
firmware download.

B TiCloud Tools x /[ Uniflash X

<« C | & Secure | https;/dev.ti.com/uniflash/#!/main/m

i UniFlash Session v About @ Hep

& settings > a0864359

Configured Device : Texas Instruments XDS110 USB Debug Probe > MSP432E401Y [download coxml] CORTEX_M4_0

Program Select and Load Images

Settings & Utilities Flash Image(s)

Memory ADST119FW_V1_0_0.txt Size: 204.33 KB | Binary: ()
Standalone Command Line
Available Action(s) - 1 Image Selected
‘ Load Image ) Verify image

Reset Actions

Click here to query available reset options]

Run Actions

Run Target After Program Load/Flash Operation

= Quick Settings

Arntasimiie naraanaliza aatsinan s Mliak ta Add anssinan

O Console % Verbose X Close

Figure 14. UniFlash: Load Image

14 BOOSTXL-ADS1119 BoosterPack™ User's Guide SBAU322—-August 2018

Submit Documentation Feedback
Copyright © 2018, Texas Instruments Incorporated


http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SBAU322

13 TEXAS
INSTRUMENTS

www.ti.com Setup Details

5. The console at the bottom of the UniFlash window shows the result of the loading process. Figure 15
shows the correct response of [SUCCESS] Program Load completed successfully. If this response is
not shown or an error message is displayed try the Load Image button again. You may have to unplug
and plug the USB cable to the LaunchPad™ again to reset communication.

1B I Cloud Tools x )/ [@ UniFlash x W\ e - X

<« C | @ Secure | https;//dev.ticom/uniflash/#}/main/msp432e401y/TIXDS110_Connection/Program a %

i UniFlash  Session +  About @ Help € settings  § a0864359
Configured Device : Texas Instruments XDS110 USB Debug Probe > MSP432E401Y [download cexmi] CORTEX_M4_0 Disconnected: Running Free
Program Select and Load Images
Settings & Utilities Flash Image(s)

Memory ADST119FW_V1_0_0.txt Size: 204.33 KB | Binary:(J

Standalone Command Line
Available Action(s) - 1 Image Selected

[IGELRET ) Verify Image

Reset Actions

[Click here to query available reset options]

Run Actions

Run Target After Program Load/Flash Operation

¥ Quick Settings

Create your personalize settings view. Click to add settings.

O Console 4 Verbose = Clear X Close

[8/28/2018, 12:03:48 PM] [INEQLCORNmbms= e siapnitialization Complete
[8/28/2018, 12:03:51 PE{]SUCCESS] Program Load completed successfully.

Figure 15. UniFlash: Successful Download
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4222

LaunchPad™ Power Configuration

To reduce the number of cables required to communicate and power the BOOSTXL-ADS1119, the USB
connection at U7 can be used as the supply source for the LaunchPad™ as well as the communication
connection for the CDC virtual COM port to the GUI. Figure 16 shows that to correctly route the power,
use the jumper installed on JP6 and connect to JP1 at the 5V-OTG (center) position. There should now be
two jumpers on JP1.

SE-‘E—: s Tt And Place on the Center Position
J5%2J7 ) of JP1 (5V-OTG)
3V3 \
PD2
PPO
PP1
*RX
®TX
PQRO
PP4
PNS X
PN4 - >3 3 vﬁ' ’1 c;ls

N (T
L.r—’TDlDTDS QLP‘
42 P11

]c47

Figure 16. Power Jumper Change

4.3 Driver Installation (If Required)

For Windows 10, the enumeration of a CDC device automatically installs the required driver on
enumeration. For earlier versions of the operating system a communication device class driver (CDC) may
need to be installed. If the driver shows as unknown, manually install the driver from Program Files
(x86)/Texas Instruments/ADS1119/drivers. Go to the Control Panel and select Device Manager. Right click
on the unknown device and select Update driver. Choose the selection Browse my computer for driver
software. Browse to the driver folder location and choose Next to locate the correct driver.

ADS1119 BoosterPack™ GUI Operation

Figure 17 illustrates the home page of the ADS1119 BoosterPack™ GUI. This page provides a high-level
overview of the ADS1119 device. Starting at the upper left portion of the GUI are various icons that refer
to particular pages within the GUI application. Along with the home page is the quick start, setup, chart,
register, and collateral pages. Each page can be selected by clicking on the appropriate icon. When the
MSP-EXP432E401Y LaunchPad™ is combined with the BOOSTXL-ADS1119 BoosterPack™ and
connected to the PC with the micro USB cable, the board is detected and connected. The connection
status is shown at the lower left corner of the GUI.
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5.1 Home Page

The Home page is the starting point of the GUI application. The five other pages can be selected from the
bottom portion of the page, or from the icons along the left-hand side of the window. By clicking on Learn
more, the ADS1119 features and functional diagram will be displayed in place of the page control tabs.
When clicking on Show Less the page control tabs are once again displayed.

File Options Tools Help

° ADS1119

¥ (=

Quick Start Settings Data Capture Registers Collateral

Powered By GUI Composer™
i3 Texas INSTRUMENTS

& co COMi3undefined Hardware Connected

Figure 17. Home Page

5.2 Quick Start Page

The Quick Start page (Figure 18) shows a minimal view of the startup procedure to get the system up and
running. For specific details see Section 4.

File Options Tools Help
= Menu

® ¥ Quick Start

o Quick Start Guide: BOOSTXL-ADS1119
Evaluation Module

== Download and install the GUI .
. Remove jumper JP§and place on the LaunchPad” power connector JP1 to the
software ADS1113 BoosterPack” GUI e center 5V-OTG position, place the BOOSTXL-ADS1119 on the LaunchPad
and connect the micro USE cable to the PC

hitp://wwweti.com/tool/boostl-ads1119

or
™= https:idev.s.comigallery

| &—

- T e .
Connect the micro USB cable to the LaunchPad™ to download the firmware e e
by starting the GUI and selecting File -> Program Device ey
wmcaanr o :

i

Powered By GUI Composer™

*i3 Texas INSTRUMENTS

&) G5 COM13undefined Hardware Connected.

Figure 18. Quick Start Page
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5.3

5.4

54.1

Settings Page

The Settings Page (Figure 19) shows that there is only one control setting on the Settings page. The
control can be used to force a hardware reset to the ADS1119. Clicking the Reset button twice forces the
reset pin low with the first click, and then returns the pin high with the second button click.

Fie  Options  Tools  Help
= Menu
~ a= Settings

¥

GPIO Controls
Output Controls

-9 reser

& co  COMi3undefined _Hardware Connected

Figure 19. Settings Page

Chart Page

There is only one Chart page option available (Figure 20) and that is the Time Domain Analysis plot. For
any data to be displayed at the data rate specified in the register setting requires the Conversion Mode
setting in the ADS1119 register to be set to Continuous.

Time Domain Analysis

The plot begins when the START button in pressed. When the chart begins to display data, the START
button changes to STOP. Data are displayed on the chart until the STOP button is pressed. There are two
ways the data can be displayed. One option is to display by voltage and the second option displays by the
number of codes. The voltage option is the default, and the voltage value displayed depends on the gain
applied in the register setting and the reference voltage being used. The default reference voltage
displayed is the internal reference voltage of the ADS1119. If another reference source is used, update
the reference voltage box to accurately display the voltage value determined at the ADC input.

Additional information is also displayed above the chart in terms of ADC conversion codes. This
information includes the number of samples, mean value, standard deviation, peak-to-peak, effective
resolution and noise-free bits of the data set collected.

18
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File Options Tools Help

= Menu

# | M Data Capture

Display VRef
¥ START Codes v 2.048
Samples Mean STDEV Ph-to-Pk ENoB NFB
6 26577441 128 7 1564 1319

25778 Codes

@ 25777

L] es

. 25776
7/

25775

B 25774

25773

25772

25771

25770

0 10 20 30 40 0 70 80 %0 100 10

25769

5 60 80
Number of Samples (104 )

Powered By GUI Composer™

Figure 20. Chart Page

5.5 Register Map Page

The Register Map page (Figure 21) displays the contents of the ADS1119 registers. Only the first register
can be written. The second register is a read-only register. Register settings can be changed using the
drop-down lists and click boxes. Information regarding the selections and options can be displayed by
using the cursor to hover over the various options.

Fie  Optons  Tools  Help

= Menu

| /' Register Map s Erysses v
. Bits
' Register Name Adress Value e . s FiELo View

v CONFIGURATION SELECT REGISTERS CONFIGURATION_REGISTER_0

= | conmiouRATION REGISTER 0 e 0x0000 0x00 0 0 0 0 0 0 0 0
= URATION SELECT REGISTERS
URATION_REGISTER_O/ INPUT_MUX(7:5] @

CONFIGURATION_REGISTER_1 0x0001 0x60

AINP = AINO, AINN = AINT

Y

o 0 e

8 CONFIGURATION SELECT REGISTERS
CONFIGURATION_REGIS 0/ DEV_DATA_RATE[3:2]
20 SPS (default)
CONFIGURATION 7 SoRVERSION_MODE[
[] CONVERSION_MODE
CONFIGURATION_REGISTER_0 / VOLTAGE_REF[0]
[ vorrase rer

Figure 21. Register Map Page
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5.6 Collateral Page

The Collateral Page (Figure 22) provides information and links to various application notes and any other
useful information as applicable to the GUI or the BOOSTXL-ADS1119.

File Options Tools Help
= Menu

# | B Collateral

) &

User Guide Data Sheet
BOOSTXL-ADS1119 User's Guide ADS1119 Datasheet
'Y
7/
Application Notes Reports
Digital Filter Types
MSP432 Firmware
Uniflash
Powered By GUI Gomposer™
E G> COM13undefined Hardware Connected. *ﬂ TEXAS INSTRUMENTS
Figure 22. Collateral Page
20 BOOSTXL-ADS1119 BoosterPack™ User's Guide SBAU322—-August 2018

Submit Documentation Feedback
Copyright © 2018, Texas Instruments Incorporated


http://www.ti.com
http://www.go-dsp.com/forms/techdoc/doc_feedback.htm?litnum=SBAU322

13 TEXAS
INSTRUMENTS

www.ti.com

Bill of Materials, PCB Layout, and Schematic

6 Bill of Materials, PCB Layout, and Schematic

This section contains the BOOSTXL-ADS1119 EVM bill of materials (BOM), printed-circuit board (PCB)

layout, and board schematic.

6.1

Bill of Materials

Table 5 lists the bill of materials (BOM) for the BOOSTXL-ADS1119 EVM.

Table 5. Bill of Materials

Designator Quantity Description Manufacturer Part Manufacturer
Number

IPCB1 Printed Circuit Board DC023 Any

C1, C2, C16 CAP, CERM, 1 uF, 10 V, +/- 10%, C1005X7S1A105K050BC TDK
X7S, 0402

C3,C4, C5,C6 4 CAP, CERM, 0.01 uF, 10 V, +/- 10%, |0402ZC103KAT2A AVX
X7R, 0402

C7, C8, C10, 7 CAP, CERM, 0.1 uF, 10 V, +/- 10%, GRM155R71A104KA01D MuRata

C11, C12, C13, X7R, 0402

C19

Ci14 1 CAP, CERM, 100 pF, 25 V, +/- 10%, 06033C101KAT2A AVX
X7R, 0603

C15 1 CAP, CERM, 22 uF, 25V, +/- 20%, TMK325B7226MM-TR Taiyo Yuden
X7R, 1210

C17, C18 2 CAP, CERM, 10 uF, 16 V, +/- 10%, GRM319R61C106KE15D MuRata
X5R, 1206

D1, D2 2 LED, Green, SMD LTST-C171GKT Lite-On

J1/33, J2/34 2 Receptacle, 2.54mm, 10x2, Tin, TH SSQ-110-03-T-D Samtec

J5 1 Header, 100mil, 3x2, Gold, TH TSW-103-07-G-D Samtec

J6 1 Terminal Block, 3.5mm Pitch, 7x1, TH | ED555/7DS On-Shore Technology

JP1, JP3 2 Header, 2mm, 2x1, Tin, TH TMM-102-01-T-S Samtec

JP2 1 Header, 2mm, 3x1, Tin, TH TMM-103-01-T-S Samtec

L1 1 Inductor, Wirewound, Ferrite, 1 uH, LQH32PN1RONNO MuRata
2.05 A, 0.045 ohm, SMD

R1, R2, R3, R4, 6 RES, 1.00 k, 1%, 0.063 W, AEC-Q200 | CRCW04021K00FKED Vishay-Dale

R13, R14 Grade 0, 0402

R5 1 RES, 100 k, 1%, 0.1 W, AEC-Q200 CRCWO0603100KFKEA Vishay-Dale
Grade 0, 0603

R6 RES, 20.0 k, 1%, 0.1 W, 0603 RCO0603FR-0720KL Yageo

R8 RES, 0, 5%, 0.1 W, AEC-Q200 Grade | ERJ-2GEOR00X Panasonic
0, 0402

R9 RES, 768 k, 1%, 0.1 W, 0603 RCO0603FR-07768KL Yageo

R10 RES, 215 k, 1%, 0.1 W, 0603 RC0603FR-07215KL Yageo

R11, R12, R16, RES, 10 k, 5%, 0.1 W, AEC-Q200 ERJ-2GEJ103X Panasonic

R18, R21, R22 Grade 0, 0402

R19 1 RES, 160, 5%, 0.063 W, AEC-Q200 CRCWO0402160RJNED Vishay-Dale
Grade 0, 0402

R20 1 RES, 100, 1%, 0.063 W, AEC-Q200 CRCWO0402100RFKED Vishay-Dale
Grade 0, 0402

SH-JP1, SH-JP2 |2 Shunt, 2mm, Gold plated, Black 2SN-BK-G Samtec

ul 16-Bit, 4-Channel, 1-kSPS, Delta- ADS1119IPWR Texas Instruments
Sigma ADC with 12C Interface,
PWO0O016A (TSSOP-16)

u2 1 3.5MHz, 1.5A, 92% Efficient Boost TPS61252DSGR Texas Instruments
Converter with Adjustable Input
Current Limit, DSGO008A (WSON-8)
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Table 5. Bill of Materials (continued)

U3

Single Output High PSRR LDO, 150
mA, Fixed 5 V Output, 2.5t0 6.5V
Input, with Low 1Q, 6-pin WSON
(DSE), -40 to 125 degC, Green (RoHS
& no Sb/Br)

TPS71750DSER

Texas Instruments

U4

I12C BUS EEPROM (2-Wire), TSSOP-
B8

BR24G32FVT-3AGE2

Rohm

Cc9

CAP, CERM, 0.1 uF, 10V, +/- 10%,
X7R, 0402

GRM155R71A104KA01D

MuRata

R7

RES, 0, 5%, 0.1 W, AEC-Q200 Grade
0, 0402

ERJ-2GEOROOX

Panasonic

R15, R17

RES, 10 k, 5%, 0.1 W, AEC-Q200
Grade 0, 0402

ERJ-2GEJ103X

Panasonic

SH-JP3

Shunt, 2mm, Gold plated, Black

2SN-BK-G

Samtec
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6.2 PCB Layout
Figure 23 to Figure 26 depict the BOOSTXL-ADS1119EVM PCB layout.
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Figure 23. Top Silkscreen
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Figure 26. Bottom Silkscreen
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6.3 Schematic
Figure 27 shows the BOOSTXL-ADS1119 schematic.
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Figure 27. BOOSTXL-ADS1119 Schematic
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STANDARD TERMS FOR EVALUATION MODULES

Delivery: Tl delivers Tl evaluation boards, kits, or modules, including any accompanying demonstration software, components, and/or
documentation which may be provided together or separately (collectively, an “EVM” or “EVMs”) to the User (“User”) in accordance
with the terms set forth herein. User's acceptance of the EVM is expressly subject to the following terms.

11

1.2

EVMs are intended solely for product or software developers for use in a research and development setting to facilitate feasibility
evaluation, experimentation, or scientific analysis of Tl semiconductors products. EVMs have no direct function and are not
finished products. EVMs shall not be directly or indirectly assembled as a part or subassembly in any finished product. For
clarification, any software or software tools provided with the EVM (“Software”) shall not be subject to the terms and conditions
set forth herein but rather shall be subject to the applicable terms that accompany such Software

EVMs are not intended for consumer or household use. EVMs may not be sold, sublicensed, leased, rented, loaned, assigned,
or otherwise distributed for commercial purposes by Users, in whole or in part, or used in any finished product or production
system.

Limited Warranty and Related Remedies/Disclaimers:

21

2.2

2.3

These terms do not apply to Software. The warranty, if any, for Software is covered in the applicable Software License
Agreement.

Tl warrants that the TI EVM will conform to TI's published specifications for ninety (90) days after the date Tl delivers such EVM
to User. Notwithstanding the foregoing, Tl shall not be liable for a nonconforming EVM if (a) the nonconformity was caused by
neglect, misuse or mistreatment by an entity other than TI, including improper installation or testing, or for any EVMs that have
been altered or modified in any way by an entity other than TI, (b) the nonconformity resulted from User's design, specifications
or instructions for such EVMs or improper system design, or (¢) User has not paid on time. Testing and other quality control
technigues are used to the extent Tl deems necessary. Tl does not test all parameters of each EVM.
User's claims against Tl under this Section 2 are void if User fails to notify Tl of any apparent defects in the EVMs within ten (10)
business days after delivery, or of any hidden defects with ten (10) business days after the defect has been detected.

TI's sole liability shall be at its option to repair or replace EVMs that fail to conform to the warranty set forth above, or credit
User's account for such EVM. TI's liability under this warranty shall be limited to EVMs that are returned during the warranty
period to the address designated by Tl and that are determined by TI not to conform to such warranty. If Tl elects to repair or
replace such EVM, Tl shall have a reasonable time to repair such EVM or provide replacements. Repaired EVMs shall be
warranted for the remainder of the original warranty period. Replaced EVMs shall be warranted for a new full ninety (90) day
warranty period.

Regulatory Notices:

3.1

United States
3.1.1 Notice applicable to EVMs not FCC-Approved:

FCC NOTICE: This kit is designed to allow product developers to evaluate electronic components, circuitry, or software
associated with the kit to determine whether to incorporate such items in a finished product and software developers to write
software applications for use with the end product. This kit is not a finished product and when assembled may not be resold or
otherwise marketed unless all required FCC equipment authorizations are first obtained. Operation is subject to the condition
that this product not cause harmful interference to licensed radio stations and that this product accept harmful interference.
Unless the assembled kit is designed to operate under part 15, part 18 or part 95 of this chapter, the operator of the kit must
operate under the authority of an FCC license holder or must secure an experimental authorization under part 5 of this chapter.

3.1.2 For EVMs annotated as FCC — FEDERAL COMMUNICATIONS COMMISSION Part 15 Compliant:

CAUTION

This device complies with part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not
cause harmful interference, and (2) this device must accept any interference received, including interference that may cause
undesired operation.

Changes or madifications not expressly approved by the party responsible for compliance could void the user's authority to
operate the equipment.

FCC Interference Statement for Class A EVM devices

NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not
installed and used in accordance with the instruction manual, may cause harmful interference to radio communications.
Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to
correct the interference at his own expense.
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FCC Interference Statement for Class B EVM devices

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to part 15 of
the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential
installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance
with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which
can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more
of the following measures:

« Reorient or relocate the receiving antenna.

« Increase the separation between the equipment and receiver.

« Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
« Consult the dealer or an experienced radio/TV technician for help.

Canada
3.2.1 For EVMs issued with an Industry Canada Certificate of Conformance to RSS-210 or RSS-247
Concerning EVMs Including Radio Transmitters:
This device complies with Industry Canada license-exempt RSSs. Operation is subject to the following two conditions:

(1) this device may not cause interference, and (2) this device must accept any interference, including interference that may
cause undesired operation of the device.

Concernant les EVMs avec appareils radio:

Le présent appareil est conforme aux CNR d'Industrie Canada applicables aux appareils radio exempts de licence. L'exploitation
est autorisée aux deux conditions suivantes: (1) I'appareil ne doit pas produire de brouillage, et (2) l'utilisateur de I'appareil doit
accepter tout brouillage radioélectrique subi, méme si le brouillage est susceptible d'en compromettre le fonctionnement.

Concerning EVMs Including Detachable Antennas:

Under Industry Canada regulations, this radio transmitter may only operate using an antenna of a type and maximum (or lesser)
gain approved for the transmitter by Industry Canada. To reduce potential radio interference to other users, the antenna type
and its gain should be so chosen that the equivalent isotropically radiated power (e.i.r.p.) is not more than that necessary for
successful communication. This radio transmitter has been approved by Industry Canada to operate with the antenna types
listed in the user guide with the maximum permissible gain and required antenna impedance for each antenna type indicated.
Antenna types not included in this list, having a gain greater than the maximum gain indicated for that type, are strictly prohibited
for use with this device.

Concernant les EVMs avec antennes détachables

Conformément a la réglementation d'Industrie Canada, le présent émetteur radio peut fonctionner avec une antenne d'un type et
d'un gain maximal (ou inférieur) approuvé pour I'‘émetteur par Industrie Canada. Dans le but de réduire les risques de brouillage
radioélectrique a l'intention des autres utilisateurs, il faut choisir le type d'antenne et son gain de sorte que la puissance isotrope
rayonnée équivalente (p.i.r.e.) ne dépasse pas lintensité nécessaire a I'établissement d'une communication satisfaisante. Le
présent émetteur radio a été approuvé par Industrie Canada pour fonctionner avec les types d'antenne énumérés dans le
manuel d'usage et ayant un gain admissible maximal et I'impédance requise pour chaque type d'antenne. Les types d'antenne
non inclus dans cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour I'exploitation de
I'émetteur

Japan

3.3.1 Notice for EVMs delivered in Japan: Please see http://www.tij.co.jp/Isds/ti_ja/general/eStore/notice_01.page BAEMAIZ
BAEShZFHMEAFY M. R—RICOVTR., KOEZREIBILEETL,
http://www.tij.co.jp/Isds/ti_ja/general/eStore/notice_01.page

3.3.2 Notice for Users of EVMs Considered “Radio Frequency Products” in Japan: EVMs entering Japan may not be certified
by Tl as conforming to Technical Regulations of Radio Law of Japan.

If User uses EVMs in Japan, not certified to Technical Regulations of Radio Law of Japan, User is required to follow the
instructions set forth by Radio Law of Japan, which includes, but is not limited to, the instructions below with respect to EVMs
(which for the avoidance of doubt are stated strictly for convenience and should be verified by User):

1. Use EVMs in a shielded room or any other test facility as defined in the notification #173 issued by Ministry of Internal
Affairs and Communications on March 28, 2006, based on Sub-section 1.1 of Article 6 of the Ministry’'s Rule for
Enforcement of Radio Law of Japan,

2. Use EVMs only after User obtains the license of Test Radio Station as provided in Radio Law of Japan with respect to
EVMs, or

3. Use of EVMs only after User obtains the Technical Regulations Conformity Certification as provided in Radio Law of Japan
with respect to EVMs. Also, do not transfer EVMs, unless User gives the same notice above to the transferee. Please note
that if User does not follow the instructions above, User will be subject to penalties of Radio Law of Japan.
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3.3.3 Notice for EVMs for Power Line Communication: Please see http://www.tij.co.jp/Isds/ti_ja/general/eStore/notice_02.page
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Iwww . tij.co.jp/Isds/ti_ja/general/eStore/notice_02.page

3.4 European Union
3.4.1 For EVMs subject to EU Directive 2014/30/EU (Electromagnetic Compatibility Directive):

This is a class A product intended for use in environments other than domestic environments that are connected to a
low-voltage power-supply network that supplies buildings used for domestic purposes. In a domestic environment this
product may cause radio interference in which case the user may be required to take adequate measures.

4  EVM Use Restrictions and Warnings:

4.1 EVMS ARE NOT FOR USE IN FUNCTIONAL SAFETY AND/OR SAFETY CRITICAL EVALUATIONS, INCLUDING BUT NOT
LIMITED TO EVALUATIONS OF LIFE SUPPORT APPLICATIONS.

4.2 User must read and apply the user guide and other available documentation provided by Tl regarding the EVM prior to handling
or using the EVM, including without limitation any warning or restriction notices. The notices contain important safety information
related to, for example, temperatures and voltages.

4.3 Safety-Related Warnings and Restrictions:

4.3.1 User shall operate the EVM within TI's recommended specifications and environmental considerations stated in the user
guide, other available documentation provided by TI, and any other applicable requirements and employ reasonable and
customary safeguards. Exceeding the specified performance ratings and specifications (including but not limited to input
and output voltage, current, power, and environmental ranges) for the EVM may cause personal injury or death, or
property damage. If there are questions concerning performance ratings and specifications, User should contact a Tl
field representative prior to connecting interface electronics including input power and intended loads. Any loads applied
outside of the specified output range may also result in unintended and/or inaccurate operation and/or possible
permanent damage to the EVM and/or interface electronics. Please consult the EVM user guide prior to connecting any
load to the EVM output. If there is uncertainty as to the load specification, please contact a Tl field representative.
During normal operation, even with the inputs and outputs kept within the specified allowable ranges, some circuit
components may have elevated case temperatures. These components include but are not limited to linear regulators,
switching transistors, pass transistors, current sense resistors, and heat sinks, which can be identified using the
information in the associated documentation. When working with the EVM, please be aware that the EVM may become
very warm.

4.3.2 EVMs are intended solely for use by technically qualified, professional electronics experts who are familiar with the
dangers and application risks associated with handling electrical mechanical components, systems, and subsystems.
User assumes all responsibility and liability for proper and safe handling and use of the EVM by User or its employees,
affiliates, contractors or designees. User assumes all responsibility and liability to ensure that any interfaces (electronic
and/or mechanical) between the EVM and any human body are designed with suitable isolation and means to safely
limit accessible leakage currents to minimize the risk of electrical shock hazard. User assumes all responsibility and
liability for any improper or unsafe handling or use of the EVM by User or its employees, affiliates, contractors or
designees.

4.4 User assumes all responsibility and liability to determine whether the EVM is subject to any applicable international, federal,
state, or local laws and regulations related to User's handling and use of the EVM and, if applicable, User assumes all
responsibility and liability for compliance in all respects with such laws and regulations. User assumes all responsibility and
liability for proper disposal and recycling of the EVM consistent with all applicable international, federal, state, and local
requirements.

5. Accuracy of Information: To the extent Tl provides information on the availability and function of EVMs, Tl attempts to be as accurate
as possible. However, Tl does not warrant the accuracy of EVM descriptions, EVM availability or other information on its websites as
accurate, complete, reliable, current, or error-free.
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6.

10.

Disclaimers:

6.1 EXCEPT AS SET FORTH ABOVE, EVMS AND ANY MATERIALS PROVIDED WITH THE EVM (INCLUDING, BUT NOT
LIMITED TO, REFERENCE DESIGNS AND THE DESIGN OF THE EVM ITSELF) ARE PROVIDED "AS IS" AND "WITH ALL
FAULTS." Tl DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, REGARDING SUCH ITEMS, INCLUDING BUT
NOT LIMITED TO ANY EPIDEMIC FAILURE WARRANTY OR IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT OF ANY THIRD PARTY PATENTS, COPYRIGHTS, TRADE
SECRETS OR OTHER INTELLECTUAL PROPERTY RIGHTS.

6.2 EXCEPT FOR THE LIMITED RIGHT TO USE THE EVM SET FORTH HEREIN, NOTHING IN THESE TERMS SHALL BE
CONSTRUED AS GRANTING OR CONFERRING ANY RIGHTS BY LICENSE, PATENT, OR ANY OTHER INDUSTRIAL OR
INTELLECTUAL PROPERTY RIGHT OF TI, ITS SUPPLIERS/LICENSORS OR ANY OTHER THIRD PARTY, TO USE THE
EVM IN ANY FINISHED END-USER OR READY-TO-USE FINAL PRODUCT, OR FOR ANY INVENTION, DISCOVERY OR
IMPROVEMENT, REGARDLESS OF WHEN MADE, CONCEIVED OR ACQUIRED.

USER'S INDEMNITY OBLIGATIONS AND REPRESENTATIONS. USER WILL DEFEND, INDEMNIFY AND HOLD TI, ITS
LICENSORS AND THEIR REPRESENTATIVES HARMLESS FROM AND AGAINST ANY AND ALL CLAIMS, DAMAGES, LOSSES,
EXPENSES, COSTS AND LIABILITIES (COLLECTIVELY, "CLAIMS") ARISING OUT OF OR IN CONNECTION WITH ANY
HANDLING OR USE OF THE EVM THAT IS NOT IN ACCORDANCE WITH THESE TERMS. THIS OBLIGATION SHALL APPLY
WHETHER CLAIMS ARISE UNDER STATUTE, REGULATION, OR THE LAW OF TORT, CONTRACT OR ANY OTHER LEGAL
THEORY, AND EVEN IF THE EVM FAILS TO PERFORM AS DESCRIBED OR EXPECTED.

Limitations on Damages and Liability:

8.1 General Limitations. IN NO EVENT SHALL TI BE LIABLE FOR ANY SPECIAL, COLLATERAL, INDIRECT, PUNITIVE,
INCIDENTAL, CONSEQUENTIAL, OR EXEMPLARY DAMAGES IN CONNECTION WITH OR ARISING OUT OF THESE
TERMS OR THE USE OF THE EVMS , REGARDLESS OF WHETHER Tl HAS BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES. EXCLUDED DAMAGES INCLUDE, BUT ARE NOT LIMITED TO, COST OF REMOVAL OR
REINSTALLATION, ANCILLARY COSTS TO THE PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES, RETESTING,
OUTSIDE COMPUTER TIME, LABOR COSTS, LOSS OF GOODWILL, LOSS OF PROFITS, LOSS OF SAVINGS, LOSS OF
USE, LOSS OF DATA, OR BUSINESS INTERRUPTION. NO CLAIM, SUIT OR ACTION SHALL BE BROUGHT AGAINST TI
MORE THAN TWELVE (12) MONTHS AFTER THE EVENT THAT GAVE RISE TO THE CAUSE OF ACTION HAS
OCCURRED.

8.2 Specific Limitations. IN NO EVENT SHALL TI'S AGGREGATE LIABILITY FROM ANY USE OF AN EVM PROVIDED
HEREUNDER, INCLUDING FROM ANY WARRANTY, INDEMITY OR OTHER OBLIGATION ARISING OUT OF OR IN
CONNECTION WITH THESE TERMS, , EXCEED THE TOTAL AMOUNT PAID TO Tl BY USER FOR THE PARTICULAR
EVM(S) AT ISSUE DURING THE PRIOR TWELVE (12) MONTHS WITH RESPECT TO WHICH LOSSES OR DAMAGES ARE
CLAIMED. THE EXISTENCE OF MORE THAN ONE CLAIM SHALL NOT ENLARGE OR EXTEND THIS LIMIT.

Return Policy. Except as otherwise provided, Tl does not offer any refunds, returns, or exchanges. Furthermore, no return of EVM(s)
will be accepted if the package has been opened and no return of the EVM(s) will be accepted if they are damaged or otherwise not in
a resalable condition. If User feels it has been incorrectly charged for the EVM(s) it ordered or that delivery violates the applicable
order, User should contact TI. All refunds will be made in full within thirty (30) working days from the return of the components(s),
excluding any postage or packaging costs.

Governing Law: These terms and conditions shall be governed by and interpreted in accordance with the laws of the State of Texas,
without reference to conflict-of-laws principles. User agrees that non-exclusive jurisdiction for any dispute arising out of or relating to
these terms and conditions lies within courts located in the State of Texas and consents to venue in Dallas County, Texas.
Notwithstanding the foregoing, any judgment may be enforced in any United States or foreign court, and Tl may seek injunctive relief
in any United States or foreign court.

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2018, Texas Instruments Incorporated



IMPORTANT NOTICE FOR TI DESIGN INFORMATION AND RESOURCES

Texas Instruments Incorporated (‘TI”) technical, application or other design advice, services or information, including, but not limited to,
reference designs and materials relating to evaluation modules, (collectively, “Tl Resources”) are intended to assist designers who are
developing applications that incorporate TI products; by downloading, accessing or using any particular TI Resource in any way, you
(individually or, if you are acting on behalf of a company, your company) agree to use it solely for this purpose and subject to the terms of
this Notice.

TI's provision of Tl Resources does not expand or otherwise alter TI's applicable published warranties or warranty disclaimers for Tl
products, and no additional obligations or liabilities arise from TI providing such Tl Resources. Tl reserves the right to make corrections,
enhancements, improvements and other changes to its TI Resources.

You understand and agree that you remain responsible for using your independent analysis, evaluation and judgment in designing your
applications and that you have full and exclusive responsibility to assure the safety of your applications and compliance of your applications
(and of all TI products used in or for your applications) with all applicable regulations, laws and other applicable requirements. You
represent that, with respect to your applications, you have all the necessary expertise to create and implement safeguards that (1)
anticipate dangerous consequences of failures, (2) monitor failures and their consequences, and (3) lessen the likelihood of failures that
might cause harm and take appropriate actions. You agree that prior to using or distributing any applications that include TI products, you
will thoroughly test such applications and the functionality of such Tl products as used in such applications. Tl has not conducted any
testing other than that specifically described in the published documentation for a particular TI Resource.

You are authorized to use, copy and modify any individual TI Resource only in connection with the development of applications that include
the Tl product(s) identified in such TI Resource. NO OTHER LICENSE, EXPRESS OR IMPLIED, BY ESTOPPEL OR OTHERWISE TO
ANY OTHER TI INTELLECTUAL PROPERTY RIGHT, AND NO LICENSE TO ANY TECHNOLOGY OR INTELLECTUAL PROPERTY
RIGHT OF TI OR ANY THIRD PARTY IS GRANTED HEREIN, including but not limited to any patent right, copyright, mask work right, or
other intellectual property right relating to any combination, machine, or process in which TI products or services are used. Information
regarding or referencing third-party products or services does not constitute a license to use such products or services, or a warranty or
endorsement thereof. Use of TlI Resources may require a license from a third party under the patents or other intellectual property of the
third party, or a license from TI under the patents or other intellectual property of TI.

TI RESOURCES ARE PROVIDED “AS I1S” AND WITH ALL FAULTS. TI DISCLAIMS ALL OTHER WARRANTIES OR
REPRESENTATIONS, EXPRESS OR IMPLIED, REGARDING TI RESOURCES OR USE THEREOF, INCLUDING BUT NOT LIMITED TO
ACCURACY OR COMPLETENESS, TITLE, ANY EPIDEMIC FAILURE WARRANTY AND ANY IMPLIED WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NON-INFRINGEMENT OF ANY THIRD PARTY INTELLECTUAL
PROPERTY RIGHTS.

TI SHALL NOT BE LIABLE FOR AND SHALL NOT DEFEND OR INDEMNIFY YOU AGAINST ANY CLAIM, INCLUDING BUT NOT
LIMITED TO ANY INFRINGEMENT CLAIM THAT RELATES TO OR IS BASED ON ANY COMBINATION OF PRODUCTS EVEN IF
DESCRIBED IN TI RESOURCES OR OTHERWISE. IN NO EVENT SHALL TI BE LIABLE FOR ANY ACTUAL, DIRECT, SPECIAL,
COLLATERAL, INDIRECT, PUNITIVE, INCIDENTAL, CONSEQUENTIAL OR EXEMPLARY DAMAGES IN CONNECTION WITH OR
ARISING OUT OF TI RESOURCES OR USE THEREOF, AND REGARDLESS OF WHETHER TI HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

You agree to fully indemnify Tl and its representatives against any damages, costs, losses, and/or liabilities arising out of your non-
compliance with the terms and provisions of this Notice.

This Notice applies to TI Resources. Additional terms apply to the use and purchase of certain types of materials, Tl products and services.
These include; without limitation, TI's standard terms for semiconductor products http://www.ti.com/sc/docs/stdterms.htm), evaluation
modules, and samples (http://www.ti.com/sc/docs/sampterms.htm).

Mailing Address: Texas Instruments, Post Office Box 655303, Dallas, Texas 75265
Copyright © 2018, Texas Instruments Incorporated
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